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Introduction

Congratulations on your purchase of the Total Organic Analyzer (TOC-VCPH/
TOC-VCcPN/TOC-VWP).

This instruction manual has been prepared for the TOC-Control V Administrator, and
describes the various operations associated with the TOC-Control V software system
administration.

Please read this manual carefully before using the software.

The TOC-V User's Manual is provided separately. Carefully read the TOC-V User
Manual before using the instrument.

A CAUTION

* Do not operate the TOC-Control V software before understanding the
contents of this manual.
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Product Warranty and Post Sale Service

Product Warranty

and Post Sale Service

Product Warranty

The warranty does not cover malfunctions that result from:
misuse;

repairs or modifications made by any company other than the
manufacturer or an approved company;

external factors;

operation under severe conditions, such as environments with high
temperature, high humidity, corrosive gas, vibration, etc.;

fire, earthquake or other forces of nature;
moving or transporting the unit after its initial installation;

normal wear of items or parts that can be regarded as consumable. The
service life of consumable items depends on the actual operating
conditions.

Post Sale Service

If any problems

occur with this instrument, inspect it and take appropriate corrective

action as described in Section 5.6 “Troubleshooting” of the TOC-V User Manual. If the
problem persists, or symptoms not covered in the Troubleshooting section occur,
contact your Shimadzu representative.

Relevant Instruction Manuals

Name Content

TOC-V User Manual Describes the procedures necessary for performing
routine operation and maintenance of the TOC-V.

TOC-V Administrator's Describes the procedures necessary for safe

Manual administration of the TOC-Control V software,

including security, user registration, etc.

TOC-V Administrator’'s Manual



Contents of This Manual

Contents of This Manual

Chapter 1 GLP/GMP Overview
Provides an overview of GLP/GMP and describes FDA 21 CFR Part 11.

Chapter 2 System Administration Overview

Provides an overview of the system administration functions that ensure protection of
the data generated using the TOC-Control V software.

Chapter 3 System Administration Operations

Describes the procedures for accessing the TOC-Control V System Administration
functions, setting up the System Administration Tool, viewing the measurement data,
and exporting and viewing data profiles, etc.

Chapter 4 Software Installation

Describes the TOC-Control V software installation procedure.

Notation Conventions

Precautionary Conventions Used in this Manual

The following precautionary conventions are used in this manual.

Convention Description

CAUTION  Indicates the possibility of slight to moderate
injury or equipment damage.

Note: Provides additional information to ensure the
correct use of the instrument.

Other Conventions Used in this Manual

Supplementary Conventions

In addition to the precautionary conventions, Tip and Reference are used to supply
additional information.

Convention Description

TIP: Indicates a particular technique, alternative
means of operation, or useful advice.

Reference: Indicates a reference location for more
detailed information.

TOC-V Administrator's Manual



Vi [ TOC-V Administrator’s Manual [



Table of Contents

INtroduction.......ecceeiiinienineininnensencnsnecsssnncsssnecssseesssssessssressssssssssesssnes iii
Product Warranty and Post Sale Service ........cccvevvvieviienciienciieeiie e v
Product Warranty ..........ccccceecveeiinienienieseeseeseesieesreeseessessneessessnenes v
POst Sale SETVICE ....eevviriieieiiiiieiieeee s iv
Relevant Instruction Manuals..........ccccoeeeoeeierinieneseseecee e v
Contents of This Manual ..........ccccceeoiiiiiiiiiieee e \%
NOtation CONVENTIONS ....cc.eevietiriieiieieniietieiterteste sttt e ste st sbeeee e e seeeseeneens \%
Precautionary Conventions Used in this Manual ..............c.ccccueeneeee. \%
Other Conventions Used in this Manual ............ccceeveviievieeieecrennenen, \%
1 Overview of GLP/GMP .......uueeieecsuernsnensnenssnecsenssaesssecssecssesssessssessnes 1
1.1 Basic Concepts of GLP/GMP..........cccveiciiiiiiiiiiecieeceeeeeeee e 2
1.1.1 GLP/GMP....ooiiee et 2
1.1.2 FDA 21 CFR Part 11 ..coooiiieiieeeeeeeeeeee e 2
2 System Administration OVervIeW........eiiceccseeiccsssnnecssssssessssssssssssssssssans 3
2.1 System Administration CONCEPLS .....ccvverveervierreeirieieeeereesiesrreseesreesseesseenns 4
2.1.1 System Administration FUNCHONS ......ccceeevveriierieeriieieeieeie e 4
2.1.2 Data Administration FIOW.........cccooviiiiiiiiiiiiiccceeeeeee e 6
2.2 Explanation of System Administration Functions..........c.ccecceeevenereeenienene 7
2.2.1 Inspection of the TOC History Database ...........c.ccceceevierieneeneenennee. 7
222 Output and Viewing of the Data Profile...........cccccceevvevievieneeniecnennn, 8
2.2.3 User AUthentiCation. .......eeveveririirieieie et 9
3  System Administration OpPerations ........cccceeeceerecccsneeccssssnsecsssssssessssnnns 11
3.1 TOC-Control V Main MenU..........ceceeviirviiiiiniinieiieneenceseesieee e 12
3.2 System Administration TOOL..........cccevieriirierieriereeeee e 14
3.2.1 USET ACCOUNLS ....eutiiiieiieeiie ittt ettt ettt sbeenbe e e ens 15
322 Database Manager .........c.cccververieerieerieenieeieeieeeeseseseesseesseesseesseessenns 18
323 Program Test (S/W Validation)..........cccceeveevienienienieeieeieeieeceiens 21
3.2.4 SECUITLY e evvtitreieeie ettt ettt e st eser et e e e b e esbeesbeesbeesseessesssesssenens 22
3.2.5 External Modules ........ccooieieiiiinieieeneeeeeeeeeeee e 28
3.2.6 Change Password ...........coceeiieiiieiiieieeieeee et 29
3.2.7 Add EVENt LOZ ...oocvviiiiiciieiieiieeee ettt v e e e 30
33 Operation HiStOTY .......ccueeiieiiiiiiiesiee ettt 31
34 Data Profile.....c.oouiiiieieieeeee e 34
3.5 Sample Table EditOr........ccoveviiiiiiiiieiiciiciecie e 38
TOC-V

Vil



4  Software Installation 41
4.1 INStallation PreCAULIONS .....cocuvveeeeeeeeeeeeeee e et eeeeeeeeeeeeeeeeeeeeeeeesenee 42
4.2 Installation PrOCEAUIE ........ooooveiiiiiiieeeeeeee et 43

4.2.1 Installation of MSDE Database .........ccoeeeeueeeeeeeeeeieeeeeeeeeeeeeeeeeeeeenes 44
422 Installation of Shimadzu User Authentication Tool.........cccceeeeennnn. 45
423 Installation of TOC-Control V Software .........coeeevvvveiiviiciiieeeeieenns 46
4.3 PDF OUtPUL SEHNES ...ecvvieevieeiieiiecre e ere e ete e s eseeesreesreesre e e esseesseesseens 51
43.1 Adobe Acrobat Installation Information...........ccceeeeevveveeeiveicneeneeeenns 51
43.2 PostScript Printer Installation.............cceeeeerieeienenieeeeeeceeeeeneen 52
TNAEX oot e e et e e s e e raee s Index-1

vigi B TOC-V e



Overview of GLP/GMP

This chapter provides an overview of GLP/GMP and FDA 21 CFR Part 11.

1.1 Basic Concepts of GLP/GMP
Provides overview descriptions of GLP and GMP, and of FDA 21 CFR Part 11.
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1.1 Basic Concepts of GLP/GMP
1.1.1 GLP/GMP

1.1

Basic Concepts of GLP/GMP

1.1.1

GLP/GMP

TIP:

GLP (Good Laboratory Practice) is a quality system that ensures the reliability of
analysis and inspection data, and GMP (Good Manufacturing Practice) defines the
standards for ensuring quality control of manufactured pharmaceutical products as well
as proper manufacturing standards. GLP and GMP are defined in United States Title 21
Code of Federal Regulations.

Inspection reliability is ensured using a method that guarantees the transparency of the
inspection process. All documentation associated with the job of inspection is
standardized, and the inspection process is recorded and archived.

A department or section, separate from the actual inspection system, is established to
perform scheduled periodic checks on the equipment and system accuracy to ensure
reliability.

The key point of this method is to manage the entire process (validation, work flow,
data) used to obtain the results, and to leave a record of that process so that it can be
used as an audit trail for the purpose of verification.

GLP/GMP are regulations for performing proper analysis and inspection. It
incorporates effective ideas for conducting the work properly and is a useful tool even
in analytical laboratories where GLP/GMP is not required.

1.1.2

FDA 21 CFR Part 11

The FDA (Food and Drug Administration of the United States) Title 21 of the Code of
Federal Regulations Part 11 (abbreviated as FDA 21 CFR Part 11) stipulates the
compliance requirements by which “electronic records and electronic signatures” are
considered equivalent to “written records and hand written signatures”.

This regulation is used to speed up the FDA approval for new pharmaceuticals
marketed in the United States. Through this regulation, electronic signatures can be
legally used with documents in electronic format, such as global and commercial
transactions and documents output from a computer.

This regulation recognizes electronic data that is generated from computerized
analytical instruments that comply with the FDA 21 CFR Part 11 even if they are
located outside the United States. This regulation is not limited to the fields of
pharmaceuticals and food manufacturing. This regulation provides a means of
substituting electronic data for paper-based data and details proper record retention
procedures.

The FDA 21 CFR Part 11 regulation deals mainly with data integrity (security), data
completeness (data and metadata) and audit trail capability. The TOC-Control V
software supports the FDA 21 CFR Part 11 data regulations.

TOC-V Administrator’'s Manual



System Administration Overview

System administration functions are provided to protect the programs and data
associated with the TOC-Control V software and to restrict user access to
software functions. This chapter provides an overview of these functions.

2.1 System Administration Concepts

This section describes the concepts of the system administration functions in
the TOC-Control V software.

2.2 Explanation of System Administration Functions

This describes the primary system administration functions for the
TOC-Control V software.



2.1 System Administration Concepts
2.1.1 System Administration Functions

2.1 System Administration Concepts

The TOC-Control V software incorporates System Administration Functions that
protect the programs and data by restricting user access to the various software
functions. By activating the System Administration Functions, it is possible to
maintain reliability and properly administer the analysis environment, data, etc., so that
the system is compliant with GLP/GMP regulations.

2.1.1 System Administration Functions

The System Administration Function allows control of the following items.

User

When this software is installed, a user who will have all the authority (system
administration authority) is registered as “Admin.” The individuals who will use this
software are registered as “Users” using the System Administration Functions.

Enter the following items when registering new users.

Parameter Description

User ID / User Name The User ID is entered for use in login, and the User
Name is entered to associate the User ID with a proper
name. The software does not permit multiple use of
identical User ID’s or User Names.

Password Registers the user login password.

User Level Selects the User Level for the user being registered.
Access is restricted to a predefined set of functions
associated with the level selected.

Access Rights Individually selects the functions to which the user will
have access.

When the user enters the registered User ID and Password in the Login screen, all of
the functions registered in the Access Rights for that user become accessible.

If the entered User ID and Password do not match any of those in the registration
database, the program will not initiate.

4 TOC-V Administrator's Manual



2.1 System Administration Concepts
2.1.1 System Administration Functions

Access Rights

The Access Rights settings restrict the functions available to the user. This software
contains the following predefined Access Right functions for each of the User Levels.
Select the User Level that contains the Access Rights required for that user.

Administrator Main User User Guest

Security settings Sample Table Sample Table File viewing
creation / editing creation / editing

Database Sample Sample

management measurement measurement

User account Measurement File viewing

creation/editing results reprocessing

Background Instrument

processing settings maintenance

History log viewing Other functions
individually defined
by the
Administrator.

Sample Table

creation / editing

Sample

measurement

Software validation

Other functions
individually defined
by the
Administrator.

Note: All of the Access Rights are assigned to the Administrator.

TOC-V Administrator's Manual
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2.1 System Administration Concepts

2.1.2

Data Administration Flow

2.1.2

Data Administration Flow

The TOC-Control V software outputs the following types of data after each sample
measurement.

The output data can be imported into external software for secure database

management.
TOC-Control V

Measurement-related Data Exportl directory Export2 directory

Data Outout ASCII file Secure storage
. . Py p in a database
. Related information > . Data using external

(me':asur.ement parameters Path to below-mentioned software
calibration curve, etc.) binary file and PDF file

Operation history

Data Profile (metadata)
Data

Related information
(measurement parameters,
calibration curve, etc.)

Above-mentioned history

PDF file
Report file

Figure 2.1 Data Administration Flow

*  After completion of each sample measurement, an ASCII file, a Data Profile
and a PDF file are output.

*  The ASCII file contains the paths to the Data Profile and PDF report file. By
using an external tool, such as the Shimadzu Agent software, the Data Profile
and PDF report file can be retrieved from this path for secure storage in a
database.

»  The Data Profile (metadata) contains, in addition to the measurement data,
information related to the measurement (calibration curve and method used,
etc.). As a result, the integrity of the data is always maintained.

* The PDF file is a report file of the measurement results. The PDF format is
supported by a wide range of software applications, and can be viewed in most
operating systems.

TOC-V Administrator's Manual



2.2

2.2 Explanation of System Administration Functions
2.2.1 Inspection of the TOC History Database

Explanation of System Administration Functions

The primary operations available in the TOC-Control V Administration Tool
(Section 3.2 “System Administration Tool”) are inspection of the TOC History
Database, output and inspection of the Data Profile, and User Authentication. This
section provides a description of these functions.

2.2.1

Inspection of the TOC History Database

Reference:

The TOC-Control V software allows the operation history to be inspected. The history
is divided into the areas of System Administration, General Operation, Create/Edit
Data, H/W Settings, Maintenance, and Errors. The time and date of the operation, the
user who performed the operation, the nature of the operation, the pre- and post-change
condition, and a comment are displayed in the operation history.

The displayed history of System Administration includes items related to user
registration, such as changes in System Administration settings, password changes,
etc., and the other functions performed with the TOC-Control V System
Administration Tool.

The Operation History can be output as a tab delimited ASCII file.

Refer to Section 3.3 “Operation History” for information on how to display the Operation
History,

== TocHistory Database 1ol x|

File  Export  Help

€ Administration € General " Create/Edit W |2002/02/06 — |2003/02/06
Operation Data Date: B2 I j I j

= HAW Settings " Maintenance ¢ Errar User: [ I Wiew History Log | i Export |

| Date | Uzer | Saurce | Ttem | Fram | Tao | Giommet

< | |

Figure 2.2 Operation History Display Window

TOC-V Administrator's Manual
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2.2 Explanation of System Administration Functions
2.2.2 Output and Viewing of the Data Profile

2.2.2

Output and Viewing of the Data Profile

The TOC-Control V software is used to perform sample measurement, and to output a
Data Profile for each sample. The Data Profile includes the measurement data, the
calibration curve and the analysis method used, so that data integrity is maintained at

all times.

Reference: Refer to Section 3.4 “Data Profile” for information on how to display the Data Profile.

TocDataProfile:
File Wiew Help

=10l x|

e 3=1k2

General Information

| v

Farameter | WValue
Date of creatian 02/06/03 14:42:20
File name TOC 2003 02 06_14 32 05 0432
Uzer System Adminiztrator
Object ID 0A-000001-10101000-131 AZFE23243-0000
System TEST
Origin testl.met
Statug Completed
Result
Farameter | WValue |
Twpe Unknown
fnal. Tvpe TG
Sample Mame a
Sample ID 1
Result TC100.0meL
Wial 1
Data
Type | SplMa | Inj Mo | Area | Conc | Ex. | Cal. Curve | [rate/Time |
TG 1 1 1114 1000 test]. 2003 02 0614 35 68.cal 02/06/03 14:41:47
TG 1 2 1114 1000 test]. 2003 02 06_14 35 B8.cal 02/06/03 14:4219

| of

I I

Figure 2.3 Data Profile Window

TOC-V Administrator’'s Manual



2.2 Explanation of System Administration Functions
2.2.3 User Authentication

223

User Authentication

Descriptions of some of the User Authentication functions are displayed below.

User ID / Password

User ID and Password authentication functions are provided to prevent
unauthorized users from using the TOC-Control V software. The User ID and
Password authentication functions are complementary, and once validated,
satisfy the conditions for the electronic signature and enable workflow
administration for each user. They provide a means of setting individual user
access rights to the various software functions.

Mail Transmission upon Login Error

As described above, TOC-Control V authenticates each user by the User ID
and Password, however, if the login fails after a previously set number of login
attempts, the PC will lock up for a specified period of time. If there is an
attempt to log in while the PC is in the locked state, an e-mail message is sent
to a previously specified destination. This function allows e-mail confirmation
of a suspicious login attempt, and ensures the security of the software.

Re-entering a Password

If no operations are performed in the TOC-Control V software within a
previously specified time period, the user ID and password input box can be
displayed to oblige the user to properly log in again before allowing any
further software operations.

Screen Lock

If the user must temporarily leave the PC during measurement, the screen can
be locked to protect the data from another individual making improper or
malicious operations. Once the screen is locked, it can only be unlocked by
entering the user ID and password of the user who was logged in at the time
the screen was locked.

Note: These functions are implemented using settings in the Security section
of the System Administration Tool. Refer to Section 3.2.4 “Security”
for details regarding setting these items.

TOC-V Administrator's Manual
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System Administration Operations

This chapter describes the procedure for accessing System Administration
within the TOC-Control V software, and performing various operations of the
System Administration Tool.

3.1 TOC-Control V Main Menu

Describes the Main Menu used for starting the TOC-Control V system.
3.2 System Administration Tool

Describes the screens used for administering the TOC-Control V system.
3.3 Operation History

Describes the procedures for displaying the history of operations performed in
TOC-Control V.

3.4  Data Profile
Describes the Data Profile output from TOC-Control V software.
3.5  Sample Table Editor

Describes the TOC-Control V Sample Table operations related to System
Administration.
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3.1 TOC-Control V Main Menu

3.1  TOC-Control V Main Menu

To start the TOC-Control V software, select Start > Programs > TOC-Control V.
The TOC-Control V Main Menu window is displayed.

=] TOG-Control 4 x|

Hdminigiration: Sample Table MNew System
Editor

ADZD)

DIM 35402 Giontrol Higtory
Part 51 Charts Database

=L IV

Data Profile

]

Figure 3.1 TOC-Control V Main Menu Window

The TOC-Control V software is made up of several modules. These modules are
accessed by double-clicking the corresponding icons in the Main Menu window. The
User dialog box shown below is displayed to enable module access.

EE x|

LUser I0:
I
Password Gancel

Eﬂ eget access to this function enter your User ID and

oUr password.
f vou don't have a user account yet, contact the
OC-Contral W System Administrator.

Figure 3.2 User Dialog Box

To gain access to the module the first time the program is executed, enter the following
default user information, and click OK.

User ID: Admin
Password: Do not enter anything.

Note: To maintain security, use the procedure in Section 3.2.6 “Change Password”
to change the “Admin” password after the first use of the program.

TOC-V Administrator’'s Manual



3.1 TOC-Control V Main Menu

System Administration Tool

Select the Administration icon to gain access to the System Administration Tool. The
System Administration Tool contains the User Accounts, Database Manager, S/'W
Validation, Background Processing, Change Password and Event Log functions.

Sample Table Editor

Select the Sample Table Editor icon to create or edit a sample table.

New System

Select the New System icon to create a new instrument system.

System Icon (“123”, etc. in above screen)

After creating a new system, naming it “123”, etc., and saving it in TOC-Control V, an
icon corresponding to that system name will thereafter be displayed in the Main Menu
window, enabling access to that system.

History Database

Select this icon to view the operation history. Only users having access rights to the
operation history can view the history database. Access to view the history is set in
User Accounts.

This icon is only displayed if the Operation History option is checked in the Security

item of the System Administration Tool.

Data Profile

Select this icon to view a particular measurement Data Profile exported from the
TOC-Control V system.

This icon is only displayed if the Data Profile Export option is checked in the Security
item of the System Administration Tool.

TOC-V Administrator’s Manual
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3.2 System Administration Tool

3.2 System Administration Tool

Click the Administration icon in the TOC-Control V Main Menu window to start the
System Administration Tool. The TOC-Control V Administrator window opens.

DIM 38402 Control Higtory
Part 51 Charts Databasze

LIViAID ZC

]

Data Profile

|
i

=)

Figure 3.3 TOC-Control V Main Menu Window

The TOC-Control V administrative functions are accessed from the TOC-Control V
Administrator window. These functions allow the system administrator to set all the
administrative parameters related to User Accounts, database creation, software
checks, security as it relates to FDA 21 CFR Part 11, output data from the
TOC-Control V, and settings for launching external applications.

Database Manager
Program Test
Security
g External Modules
Chanee Password
Add event log

Figure 3.4 TOC-Control V Administrator Window

14 TOC-V Administrator's Manual



3.2 System Administration Tool
3.2.1 User Accounts

3.2.1

User Accounts

File Menu

User Menu

The User Accounts function allows the System Administrator and authorized users to
create new user accounts, modify existing user information, and activate or deactivate

user accounts.

Uzer 1D | Lger Mame | User Level | Activate/Deactivate |
Admin Swstem Adminiztrator  Administrator Activated
Shimadzu Taro Shimadau Main user Activated

Figure 3.5 TOC-Control V User Window

Close

After completing user registration tasks, select the Close command to return to the

TOC-Control V Administrator window.

New

To add a new user to the system, select New. The New / Edit User dialog box is

displayed.

[*] User D :

[*] Uzer Mame :

[*] Pazzword :

[*] : Required ltem

|| Company:
I Position:
[*] Cofirm Mew Password : I Tel. Mumber:

Department:

E-mail &ddress:

Comment : I

User Level
7 Admiristrator
& Main User
= User
" Guest

I

Detailed Access rights

[ 1Create/Edit User -
[15ecurty Setting

(1D atabase Management

[w] 5/ W alidation

[C1Estemal Module Setting

[w]5ample Measurements

[w]*iew Files

[w] R e-calculation

[w]Create/E dit Methods LI

Cancel |

Figure 3.6 New / Edit User Dialog Box

TOC-V Administrator's Manual
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3.2 System Administration Tool
3.2.1 User Accounts

Command

Description

User ID (required)

User Name (required)

Password (required)

Confirm New Password
(required)

Company, Department,
Position, Tel. Number,
E-mail Address, etc.

User Level

Access Rights

TOC-V Administrator’'s Manual

Enter a User ID in this text box. The User ID can contain
a maximum of 30 characters.

Enter a User Name in this text box. The User Name can
contain a maximum of 60 characters.

Enter a password in this text box. The length and other
conditions for the password are specified in the
Shimadzu User Authentication Tool > Configuration >
User Authentication Tool Configuration Settings. Refer
to the Shimadzu User Authentication Tool instruction
manual for instructions. The password is encrypted and
is displayed with asterisks (*).

To verify the password, carefully type into the Verify
Password text box the same password entered in the
password text box. The password is case sensitive.

Enter these items, as necessary.

Select the appropriate radio button to set a User Level.
* Administrator

* Main User

* User

* Guest

Default access rights for each user level are displayed.
Create / Edit User Accounts and Security Setting access
rights items cannot be deleted from the Administrator
User Level or added to any other User Level.

The administrator can select the functions accessible to
each user. Each of the 4 user levels is provided with
certain default access rights. (Refer to Table 3.1
“Default Access Rights”) The administrator can assign
or remove access rights from Main User, User or Guest
levels. The administrator has complete access as the
default.



3.2 System Administration Tool
3.2.1 User Accounts

Table 3.1 * Default Access Rights

Task A Main User User Guest
trator

Create / edit user accounts O

Security settings

Database Management
S/W Validation

Background processing
settings

Sample measurement

View Files

Recalculation

Create / edit method

Create / edit calibration curve

Create/edit control template

Instrument maintenance

Create / edit sample table

Create instrument settings
(system)

Change instrument settings

Use control charts

O|O0|0O| © |O|0|0|O0|0|0|0O|0

Use method validation

View history

C|O0|0|0|O0| © |O|O0|O0|0|0|0O|0O|0O| O |O|0O|O0O

Add event log

Activate / Deactivate

Use this command to deactivate a user that is registered on the system, or to activate a
user that has been previously deactivated. Once a user is registered, that user cannot be
deleted from the TOC-Control V User window. Remove a user from the system by
selecting “Deactivate” in the Activate / Deactivate column.

To change a user's Activate / Deactivate setting, select the appropriate User ID in the
TOC-Control V User window. Next, click the Activate / Deactivate command in the
User menu. When the Comment dialog box opens, enter a reason for making the
change, and click OK. If a reason is not entered, an error message is displayed, and the
change is not executed. When the change is executed, the new setting is displayed in
the Activate / Deactivate column of the TOC-Control V User window.

TOC-V Administrator’s Manual
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3.2 System Administration Tool
3.2.2 Database Manager

Edit

To edit settings for a previously registered user, select the appropriate User ID in the
TOC-Control V User window. Next, click the Edit command in the User menu. When
the Create / Edit User Accounts dialog box opens, enter the appropriate information in
the item to be edited. For detailed information about the Create / Edit User Accounts
dialog box, refer to the Create New item.

Settings for a user that is currently “Deactivated” cannot be edited. To edit this
information, change the user status to “Activated.”

Help Menu Version Information
This displays the TOC-Control V version number and copyright information.
3.2.2 Database Manager

Database Manager allows the administrator or authorized users to organize
TOC-Control V data or to export it to MS-Access. Use Database Manager to create a
new database by deciding which columns are to be included. An existing database can
be opened or compressed. Database Manager can be used to repair a compressed data
file that has become corrupted.

Available Columns: Columns in database:
Sample_Mame -
Sample_ID j LI
Origin
Cal Curve ;I
Twpe
fnalysis ;I
Sparge_Time
Acid_Addition =l <«
Create | Qpen | Compress | Bepair |

Figure 3.7 Database Administration Dialog Box

Database
To open an existing database, either enter the entire directory path including the file

name into the Database text box, or click _-| to browse for and select the file.

Note: Enter a new database file name with the extension .mdb to create a new
database.

Available Columns

The Available Columns list box displays a list of all the data categories available for
output.

TOC-V Administrator’'s Manual



3.2 System Administration Tool
3.2.2 Database Manager

Columns in database

This box lists the columns selected for inclusion in the database. If an existing file is
opened, the columns included in the database are displayed in this box.

Create

Click Create to construct a database using the columns listed in the Columns in
database box.

Open

Click Open to access an existing database.

Compress

Click Compress to compress an existing database.

Repair

Click Repair to repair a database file that was damaged during the compression
process.

Creating a Database

To create a database, select the appropriate columns from the Available Columns text
box, and click _>_| to copy the selected column into the Columns in database box. To
display all of the Available Columns, click _> |. After the desired columns are

displayed in the Columns in database list box, click Create to construct the database.

Note: Double-clicking on a column in the Available Columns list box will also copy
the column into the Columns in database list box.

TOC-V Administrator’s Manual
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3.2 System Administration Tool
3.2.2 Database Manager

Opening a Database
To open an existing database, either enter the entire directory path including the file

name into the Database text box, or click | to browse for the file. Once the file name
is in the database field, click Open. The Database View window is displayed. Database
information cannot be edited in the Database View window.

X
ID(Sample_Mame| Sample_ID (Origin (Cal Curve| Type Analysiﬁ#‘_"‘e Acid_A ~ |
ime
p 1 <Untitleds Ontitled> Unknown (TG 1] [
27 Entitle d Znditie d Unkromwn T 1] 1]
3 dlntitle d> Znditie d Unkromn TR 1] 1]
4" dintitle d> Znditie d Unkromn TR 1] 1]
-
M| 4| Record 1 r M| 4 _’l—

Figure 3.8 Database View Window

Importing Columns from a Database
Open a database. Select the desired columns in the Columns in database list box, and

click _<|. To import all of the columns, click _<|. The imported items can be used to
create a new database.

Note: Double-clicking on the columns in the Columns in database list box will also
import those columns.

Compressing and Restoring Database Files

Open a database file, and then click Compress to shrink the file size. A message is
displayed to indicate that the file compression has been executed normally. At times, a
file may be damaged during the compression process. To repair a damaged file, first
open that file, and then click Repair. A message is displayed to indicate that the file has
been Repaired normally.
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3.2 System Administration Tool
3.2.3 Program Test (S/W Validation)

3.2.3

Program Test (S/W Validation)

The S/W Validation function verifies that the TOC-Control V program files have not
been modified since installation. The TOC-Control V program files consist of
executables, DLL files and Help files. This function can be used only by users having
access rights to S/W Validation.

Select S/W Validation in the TOC-Control V Administration Tool window to open the
TOC-V Program Test dialog box.

TIZZ:II::Z:—"-.-" Program Test ﬂ
Program Mame and Wersion:
ITOO—OontroI W 10801
Installation directory:
IO:¥TOOS2D1
Mame | Path | Size | Checksum | \ergion | Result | -
CCDatadll CHTOCI201.. 77824 193F 1,061
COWizarddll CHTOCI201.. 118784 26C4 1,061 %
Check User.dil CHTOCI201.. 48056 2084 1,061 L
CommDLL32dIl  CHTOCI201.. 417792 3441 1,061
ContrChartzexe  C¥TOCI201.. 1204224 1EC4 1,061
FileChl32.dll CHTOCI201.. 32768 DFa 1,061
Meth'/alexe CHTOCI201.. 1196032 1AF4 1,061
MethialDIlLdIl CHTOCI201.. 53248 1487 1,061
PreCheckDIldll  CH¥TOC3201.. 24576 1954 1,061
Tocd2HistoryDB. O¥TOCI0T. 67344 1084 1051 =
Start | Beport |

Figure 3.9 TOC-V Program Test Dialog Box

Click Start to initiate the program file check. When all the files of a particular type are
checked, the results are displayed in the Name, Path, Size, Checksum, and Version
columns to the right.

Click Report to print the results.
Click Close to close the Program Test dialog box.
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3.2 System Administration Tool
3.2.4 Security

3.24 Security

The Security function is used to make software security-related changes. This function
ensures compliance with FDA 21 CFR Part 11 and can only be used by users having
Security Settings access rights.

Select Security in the TOC-Control V System Administration Tool window to open the
Security dialog box.

Security x|

¥ Audit Tirail _DK
~ Comment Required for
Modifications el |

¥ | Data Profile Export
¥ PDF Report Expart
£ Uze POF Whiter

& Uz Distiler

¥ | WserlD/Password

¥ Re-enter Password I 5_:| min

¥ | Prohibit Deletion of Measured Data
¥ Frohibit Editing of b easured Diata

V¥ Delete Temporary Data on Local PC

¥ | Wse TOCY Gateway
[V Delete exported files

Address: To

Domain Address

Mail Server

Part Ma.

Figure 3.10 Security Dialog Box

Audit Trail

Select this item to save the operation history in a MSDE format database. If this item is
selected at installation, it cannot be changed thereafter.

Select “Comment Required for Modifications” box to require mandatory comment
entry for the audit trail. This item is only displayed if Audit Trail is selected.

Comment x|

Item : |Buzzer

Comment the modification :

Figure 3.11 Comment Dialog Box
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3.2 System Administration Tool
3.2.4 Security

Data Profile Export

Select this item to output the measurement results Data Profile after each measurement.
If this item is selected at installation, it cannot be changed thereafter. The Data Profile
is output in the following situations.

*  Upon completion of each sample measurement
*  When performing recalculation of measurement results

*  When excluding a value from the measurement results

PDF Report Export

Select this item to output a data profile report file in PDF format when the data profile
is output. This item is only displayed when Data Profile Export is selected.

Use PDF Writer/Distiller

Select the output driver for the PDF output. This item is only displayed if PDF Report
Export is selected.

User ID/Password

Select this item to enable the User ID and Password functions. If this item is selected at
installation, it cannot be changed thereafter.

Re-enter Password

Select this item to require the user to re-enter the User ID and Password after the
instrument remains idle for a specified period of time. If the specified time is set to 0, it
is equivalent to having not selected this item.

Re-enter Password x|
Eries 15 o vt gt
Cancel |
Uszer ID: I
Pazsword : l—

Figure 3.12 Re-enter Password Dialog Box
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3.2 System Administration Tool
3.2.4 Security

Prohibit Deletion of Measured Data

Select this item to prohibit measurement data from being deleted from the sample table
after measurement. If this item is selected at installation, it cannot be changed
thereafter.

O Undo Citrl+2 | ?

File | Edit Miew [hsert Ihstrument Tools Options Window Help
—— | i Cut Gt

H | Cei ey Citel+ G a0

B Paste Sty MR Thstr: R

Type fnalysiz  |Sample Mam| Sample

B
% Beplace
=

Eind

> Exclude

Recalculate
b2 Al \
Import I ﬂlghllg:hted V4

]
7|
4]

&

Figure 3.13 Prohibit Deleting Measured Data

Prohibit Editing Measured Data

Select this item to prohibit editing of any measurement data information after
measurement. Editing of property items, deletion of data, recalculation, and deletion of
measurement data are all prohibited.

Sample / Methad Properties =

Parameter |TO | Higtoryl

Bnalysis:  [T0 = Status: IOompT
Dilution: I 1.000

Sample Mame:

Sample I0:

|z
i
Ma. af Determinations: I 1_%

™| Perfarm sample checking accardine to USP/EP

Brint |

Current Method: IC:¥TOOS2D‘I ¥Methods¥test] met

Cloze

Figure 3.14 Example of “Prohibit Editing of Measured Data” Status

Delete Temporary Data on Local PC

Select this item to delete all temporary files, including *.t32 files and *.pkt files in the
“install folder\Data” folder, and all *.txt files in the “install folder\Export1” and
“\Export2” folders when the Sample Table Editor is closed.
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3.2 System Administration Tool
3.2.4 Security

Use TOC-V Gateway

Select this item to convert the Data Profile and text files to the general purpose format
required by Class-Agent. If this item is selected at installation, it cannot be changed
thereafter.

The TOC-Control V software exports a text file to the “install folder\Export1” folder.
The text file reflects the content of the data profile when it is output. The TOC-V
Gateway software opens and converts this file to Class-Agent format and outputs it to
the “install folder\Export2” folder.

& DA-0000001-10101000-131A2FE232A3-0000.txt - Notepad =ol x|

File Edit Format Help

[Sample Info.] B

Same | e Mame a

Samezle 1D 1

Samgz e Twee Urkrionn

Meas. Type T

Data Twee TOCY-Unkrown

Obiect 1D 0A-000001-10101000-13142FE23243-0000

User System Administrator

Swstem  TEST

Conc.  TG:100. Ome/L

Vial 1

Date/Time 2003/02/06 14:42:20

Mari. Dil. 1.000

Mote

Comment

Status Completed

Sample Table  TOC_2003_02_06_14_39_05_0.132

Origin testl.met

Data Flag Faw Oata

[Data Info.]

Tupe Sel. No. Inj. Mo. Area Mean Area Conc.  Mean Corc. Exclude ™

TC 1 1 1116 1116 100.0 100.0 0.000  0.000 0.000 0.000

TC 1 2 1116 1116 100.0 100.0 0.000  0.000 0.000 0.000

[Lirk Files] 5

4 | Mo
Figure 3.15 TOC-Control V Export Text File

& DA-0000001-10101000-131A2FE232A3-0000.txt - Notepad =1ol x|

File Edit Format Help

<Irst rumentho> 1 =

<Irst rumentKind> TOCY-Unknown

<Samp | elame> a

<SamplelD> 1 [%

<Samp | elveer Urkrown TG

<Operator> Swatem bdministrator

<OperateDate>  2003/02/06 14:42:20

<MarazeF lazb> 1

<DelFilel> C:¥TOC3201¥RawData¥0A-000001-10101000-131A2FE232A3-0000.1 rd

<DelFile?> C:¥TOC3201¥Rawlata¥0A-000001-10101000- 131A2FE232A3-0000. +xt

<DelFiled> C:¥TOC3201¥RawData¥0A-000007-10101000- 131 A2FE232A3-0000. pdf

<Filel> C:¥TOC3201¥RawData¥0A-000001-10101000-131A2FE23243-0000. 1 rd

<File2> C:¥TOC3201¥RawData¥0A-000001-10101000-131A2FE23243-0000, txt

<Filell> C:¥TOC3201¥RawData¥0A-000007-10101000-131A2FE232A3-0000. odf

<Filelnfol> 0A-000001-10101000-13142FE23243-0000

<Filelnfo2> test1.met

<Tagl>

<Tag?> TC:100. Ome/L

<Tag3>

<Tagd> TEST

<Tazhr

<Tazh>

<Tagi>

<Tagh> Completed -

<Commert >

<Data» /P1=TC /P2=1  /P3=1  /L1=1  /L10=1 /D1=1118 A02=100.0 /03=1116 -

< | ap

Figure 3.16 Gateway Software-Generated Class-Agent Format File Converted from Text File
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3.2 System Administration Tool
3.2.4 Security

Delete Exported Files

Select this item to register the Data Profile, text and PDF files that are exported from
the TOC-Control V for deletion. Files that are registered for deletion are automatically
deleted when data collection is performed by the general purpose Agent. This item is
only displayed if the Use TOC-V Gateway item is selected.

.'J 0A-0000001-10101000-131AZFE232A3-0000.txE - Notepad = Dlﬂ

File Edit Formst Help

<Inst rumenthla> 1

|»

<Inst rument Kind> TOCY-Unknown
<Same | etlame> a

SamplelD> 1

<SampleTyper Urknown TC
Operator> System Administrator

Dperatelater  2003/02/06 14:42:20

<Filel> C:¥TOC3201¥RawData¥0A-000001-10101000-131A2FE23243-0000.1 rd

<File?> C:¥TOC3201¥Rawlata¥0A-000001-10101000-131A2FE23243-0000. 4xt

<Filell> C:¥TOC3207¥Rawbata¥04-000007-10101000-131AZFEZ32A3-0000. pdf

<Filelnfol> 0A-000001-10101000-131A2ZFE23243-0000

<Filelntol> test].met

{Tagl>

<Tag2>» TC:100.0meL

<Tagi»

{Tagd> TEST

<Jagh>

{Tagh>

<Jagl>

<Tag8> Completed -
<Comment>

Datar P1=TC /P2=1  /P3=1  Al1=1 A10=1 /D1=1116 A02=100.0 /03=1116 v
4 | AW

Figure 3.17 Files Registered for Deletion
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3.2 System Administration Tool
3.2.4 Security

Send E-mail on Login Failure

Select this item to send a notification message to a specified e-mail address if login is
attempted following a software lockup. The software locks up after a preset number of
failed login attempts.

The number of failed login attempts is set in Shimadzu User Authentication
Tool>Configuration>User Authentication Tool Configuration. Refer to the User
Authentication Tool Instruction Manual at the back of this manual for information on
the setting method.

The Address: From, Address: To, Domain Address, Mail Server and Port No. items are
only displayed when the Send E-mail on Login Failure item is selected.

Configuration of user authentication tool x|
In cases where multiple applications share the same server,
changes to these settings become valid
for all applications.
This may require changes to user information
for each application.
To validate any changes, click the Update button.
After the set number of attempts to login from a PC failed,
the PC is locked out.

Minimum password length ;|0 characters Maximum password age : ID days

¥ Same password is permitted

™ Passwords must meet complexity reguirements

User lockout duration :|15 minutes User lockout after |3 had login attermpts
FC lockout duration :|15 minutes P lockout after : |3| had login attermpts
Description :

v S I

Default Update Exit

Server | CUWINNTSystem32\SMZATST . MDE

Figure 3.18 User Authentication Tool Configuration Window

™ Accessed Illegaly ! - Message {Plain Te - |EI|1|
J File Edit Wiew Insert Format Tools | Actions Help

J!}Jﬁeply | € Reply to Al | W Forward | = | v ||:B * | @ &
From: TOC-Control ¥ Sent: Tue 2f25/2003 4:14 PM

To Admin

o
Subject:  Accessed Ilegaly |

An illegal access was detected !

|

Figure 3.19 Login Failure E-mail Message
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3.2 System Administration Tool
3.2.5 External Modules

3.2.5

External Modules

External Modules can launch external software modules linked to TOC-Control V to
run in the background before and after measurement. Use this function to import or
export data using LIMS, etc.

Select External Modules in the TOC-Control V Administrator window to display the
Background Processing dialog box.

This function can only be used by users having access rights to Background Processing
Settings.

Background Processing ll

™ Enable online 45CI export

File: [TOCDATATXT
™| Export whle sample table

™ Launch application before a sample run

Executable:l

™ Launch application before a new sample

Egecutable:l

" Launch application after a new sample

Exegutable:l

™ Launch application after a sample run

afiafafiain

Exec:gtable:l

Cancel |

Figure 3.20 Background Processing Dialog Box

Enable online ASCII Export

This function exports data in ASCII format. The data is exported after at least one
sample (one row in the sample table) has been measured. Data from TOC-Control V is
exported online in ASCII format.

Launch External Application

External applications can be initiated by the TOC-Control V software at 4 points in the
measurement sequence; before starting a sample run, before starting a new sample,
after finishing a sample and after the completing a sample run. The necessary external
applications include either external database initialization before each sample
measurement, or data output to a Laboratory Information Management System
(LIMS). Select the times for the external application to be launched by placing a check
mark in the corresponding check box. Enter the full path of the Executable File
including file name for the application to be launched, or click Search for File and
select the appropriate file.
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3.2 System Administration Tool
3.2.6 Change Password

3.2.6

Change Password

This function is used to change the password

of a registered user.

Select Change Password in the TOC-Control V System Administrator window to open
the Change Password dialog box. This function can only be used if the User 1D/
Password item is selected in the Security dialog box (see Section 3.2.4 “Security”).

4 TOC-Control ¥ Administrator

Frogram Test |
Security |

I. Change Pazsword

[atabasze Manager

External Modules

Add event log

Figure 3.21 TOC-Control V Administrator Window

User ID: ||—

Password: l—

Mew Password: l—
Cofirm Mew Pagsword: l—

[ oc 1|

Cancel |

Figure 3.22 Change Password Dialog Box
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3.2 System Administration Tool
3.2.7 Add Event Log

3.2.7 Add Event Log

This function adds a comment to the operation history. This function is useful for
documenting items in the operation history, such as the replacement of catalyst, that
cannot be recorded automatically through the software. Only users with access rights to
Add Event Log can use this function.

This function can only be used if Audit Trail is selected in the Security dialog box (see
Section 3.2.4 “Security”).

Select Add Event Log in the TOC-Control V Administrator window to display the Add
Event Log dialog box.

Add event log x|

Choose an item
(* Administration ( General Operation ¢ Create/Edit Data

" HAW Settines  © Maintenance  Errar

Commenti250 characters at masth:

F— B Gancel |

Figure 3.23 Add Event Dialog Box

Select one of the items in the “Choose an item” box, and then enter a comment in the
Comment text field. If the Comment text field is left blank, an error message is
displayed, and the comment is not added to the Event Log.
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3.3

3.3 Operation History

Operation History

It is possible to save the operations performed in TOC-Control V. This function allows
one to view the history of those operations. This function can only be used by users
with access rights to View History.

This function is only available if Operation History has been selected in the Security
dialog box (see Section 3.2.4 “Security”).

Click the History Database icon in the TOC-Control V Main Menu window to open the
TOC History Database window.

Editar

\;," DIN 32402 Contral History
\/ Part 51 Charts Database
=
T @
F Data Profile
Fall o
N/
Figure 3.24 TOC-Control V Main Menu Window
-0 x|
€ Administrati G | € Create/Edit x| — =
ministration oggre;taim Sreilz Date: ™ |2nnz/nz/nﬁ J |2nns/nz/nﬁ J
= HAW Settines ¢ Maintenance ¢ Errar User: T I Wiew History Log | fiscii Export |
| Date | Uzer | Saurce | Ttem | Fram | Tao | Giommet
« | Wl

Figure 3.25 TOC History Database Window
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Menus

peration History

File > Open > General Operation, Create/Edit Data, Administration, H/'W

Settings, Maintenance, Errors

Each of these items displays an operation history for their respective group.

File > Open > Old Version History

This function allows the user to access History Database files created on software prior
to TOC-Control V Ver1.06.00. Select this function to display the files, and select the

appropriate file.

= TocHistoryDatabase
File Export  Help

Open...

Exit

3

I Date

General Operation
Create/Edit Data
Administration
Hj'W Settings
Maintenance

eate

Errar

Figure 3.26 Select File Screen

Export > ASCII

The selected operation history is output as a tab delimited text file.

.,J ddddd.txt - Notepad

File Edit Format Help

~=1aix|

C:¥Documents and Settines¥a¥b¥ddddd. txt 02/06/03 15:21:58 B
Date User Source  [tem From to Comment

02/06/03 15:15:12 Swstem Administrator Re-erter password

0206403 10:14:47 Security Settinegs Logout

0206403 15:14:36 Security Settings Login

0206403 14:57:27 Swstem Administrator External Modules Logout

0206403 74:00:33 Swstem Administrator Extarnal Modules Login

02/06/03 14:42:20 Svstem Administrator  0A-000001-10107000-13142FE23243-0000 Samele completed
02/06/03 14:41:15 Svstem Administrator  0A-000001-10107000-131A2FE23243-0000 Measurement started
02/06/03 14:40:35 System Administrator  0A-000001-10107000-13142FE23243-0000  Sample added

02/06/03 14:39:049 Swstem Administrator TEST Communicat ion started

0206403 14:39:07 Swstem Administrator TOC_2003_02_06_14_39_05_0.132  Sample table created.

0206403 14:38:55 Swstem Administrator TEST Communi cat ion =topped

02/06/03 14:37:10 System Administrator  0A-000001-10107000-13TA2FEZ3097-0000  Sample completed
02/06/03 14:35:58 Svstem Administrator  0A4-000001-10107000-13142FE23097-0000 Measurement started
02/06/03 14:35:11 Svstem Administrator  0A-000001-70107000-131TA2FE23097-0000  Cal curve added testl
02/06/03 14:32:22 Swstem Administrator TEST Communicat ion started

02/06/03 14:32:20 Swstem Administrator TOC_2003_02_06_14_32_18_0.132  Sample table created.

0206403 14:31:39 System Administrator  Smpl. Thl. Log in

0206403 14:31:28 Swstem Administrator Security Settings Logout

0206403 14:37:28 Swstem Administrator Security Settirgs Time for re-entering password 1
02/06/03 14:31:21 Svstem Administrator  Security Settines Login

02/06/03 14:31:10 Svstem Administrator  Smel. Thl. Loz out

02/06/03 14:31:10 Swstem Administrator Re-erter password

02/06/03 14:27:18 Swstem Administrator TOC_2003_02_06_14_27_15_0.132  Sample table created.

02/06/03 14:27:05 System Administrator  Smel. Thl. Log in 5
1l | AW

Figure 3.27 Example of Tab Delimited ASCII File Export
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Radio
Buttons

Check
Boxes

Buttons

3.3 Operation History

(Administration, Create/Edit Data, General Operation, H/W Settings,
Maintenance, Error)

Select the desired item, and click the View History Log button. The appropriate
operation history is displayed. Multiple items can be selected and displayed
simultaneously.

(Time Period, User Name)

Date
Select the date and time range of the operation history to display.

User

Select a specific user name of the operation history to display.

(View History Log, ASCII Export)

View History Log

Click this button to display the operation history determined by the radio button and
check box settings.

ASCII Export
Click this button to output the displayed item in a tab delimited text file.
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3.4 Data Profile

3 . 4 Data Profile

This function is used to output the data profile from TOC-Control V so that it can be
displayed. Each row of the TOC-Control V sample table is output as an individual data
profile.

This function can only be used if Data Profile Export is selected in the Security dialog
box.

Three methods are available for displaying a data profile. The user ID and password
are not required to access any of the display methods.

1. Double-click the Data Profile icon in the TOC-Control V window, or select the
icon and press Enter.

= TOC-Cantral W x|

a0 T :
\;," wet DIM 38402 Gantral Histary
Part 51 Charts Databaze

Data Profile

Figure 3.28 TOC-Control V Main Menu Window

2. Select the row in the sample table that you wish to display, and then select
View > Data Profile.

3. Locate the file (.trd file) saved in the Data folder, a sub-folder of the TOC3201
folder, and double-click on the file name.
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Menus

3.4 Data Profile

I [m] |
Eile Miew Help
eI =1k
Genearal
Parameter I Walue I I
Date of creation 02/06/03 144220 by
File name TOC_2003_02_06_14 39 05 01132
Uszer Swatem Administrator
Object ID 0A-0000071-10101000-1:31 AZFE232A3-0000
System
Origin testl.met
Status Completed
Result
Parameter | Walue
Tvpe Unknowen
Anal. Type TC
Sample Name a
Sample 1D 1
Result TCA000me /L
Wial 1
Data
Tupe | Spl Mo | Thj Mo | Area | Gonc | Ex. | Cal. CGurve | Date/Time
TG 1 1 M 1000 test] 2003 02 (6 1435 bEcal 02706703 14:41:47
TG 1 2 me 1000 test] 2003 02 061435 56.cal 02/06/03 14:4213
4

Figure 3.29 Data Profile Dialog Box

File > Open
Opens the selected file.

View > Parameters

Displays the measurement parameters.

View > Reference Source

Displays any source files that may have been used at the time of measurement,
including the calibration curve file, method file and comment template.

View > H/W Settings

Displays the instrument settings used at the time of measurement.

View > View PDF
Displays a PDF report file, if one exists in this Data Profile folder, for that sample.

Note: The information displayed for the above items cannot be edited.
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3.4 Data Profile

Commands
Right-click in the Type column of the Data display area to open the Data right-click
menu. View Peaks and View Cal. Curve commands are described below.

A-000001-10101000-1 0. e =] 3

Eile  Miew Help

FEIE T 3=1K

Genearal
Parameter | Value
Date of creation 02/06/03 144220
File name TOG 200302 06 _14_39 06 0132
Uszer System Administrator

Object ID 0A-000001-10101000-131 A2F E232A3-0000

System

Origin testl met

Statuz Gompleted

Result
Parameter I Walue I
Type Unknown

Anal Type TG

Sample MName a

Sample ID 1

Result TCA000me/L

Vial 1

Data
Twpe | Spl Mo | Inj Mo | Area | Giohc: | [=3% | Gal. Curve | Date/Time

1 1 16 1000 test1 2003 02 06_14_35 B8.cal 02/06/03 14:41.47
TC  View Peaks 6 1000 test] 2003 02 06 14 35 58.cal 02/06/03 14:42189
4

Figure 3.30 Right-Click Menu

View Peaks

Displays the measurement peaks.

1000

200

GO0

Signallm*]

Timeihin)

Figure 3.31 Peak View Window
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View Cal. Curve

Displays the calibration curve if one was used during measurement.

Calibration Curve Properties

122719

Figure 3.32 Calibration Curve Properties Window
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3.5 Sample Table Editor

3.5

Sample Table Editor

This section describes the system administration-related operations in the Sample
Table menu.

Data Profile
Displays the Data Profile for each row in the Sample Table.

View

This function can only be used if Data Profile Export is selected in the Security dialog
box (see Section 3.2.4 “Security”).

Select the desired row in the Sample Table to view the data profile. Select View > Data
Profile to open the Data Profile dialog box.

e Table - Ti

File Edit |View Ihsert Instrument Tools Options Window Help

1%, Calibration Curve.. JJ
i Method.. PEODX = |k
Sample Window...
BD T0q g Qutlier Test Thst Read
H | = =i S0y
- =d
[ G Properties.. = [Sample Nam| Sample 1D
=] 123 ;
Customize..

TES

|§| TES ’TIoolbar
|§| wet ’Tﬁtatus Bar

Show all control bars

ASI S BPort Sampler Vials...

Figure 3.33 Data Profile Command
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0A-000007 =107 01 -101 x|
File View Help

eI 1=

Gienearal

Parameter | Malue I, |
Date of creation 02/06/03 14:42:20 13

File name TG 200302 0614 39 05 032

User System Administrator

Object ID (0A-000001-10101000-131 A2F E232A43-0000

System

Origin testl met

Status Completed

Result

Parameter | Value |
Twpe [

fnal. Tvpe Tz

Sample Name a

Sample 1D 1

Result TC:1000mesL

Wial 1

Data

Type | Spl Mo | Thj Mo I Area | Cone | Ex I Cal. Curve | Date/Titme:

TG 1 1 me 1000 test] 2003 02 061435 bB.cal 02/06/03 144147
TG 1 2 M 1000 test] 2003 02 6 14_35 B8cal 02/06/03 14.42:19

L
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3.5 Sample Table Editor

Screen Lock Function

If a user must temporarily leave the PC he/she is logged into, the screen can be locked
to prevent another individual from performing operations in TOC-Control V by using
the password function.

This function can only be used if the User ID / Password item is selected in the
Security dialog box.

Select Screen Lock in the Tools menu to lock the screen. The screen is locked and the
Re-enter Password dialog box is displayed. Enter the user ID and password to release
the screen lock. If the user ID and password do not match those used by the logged in
user, the screen lock is not released.

tral W Sample Table - - 02 06 1
File Edit Miew Ihsert Ihstrument | Tools Options Window Help
0DE | | I B |§ | % Control Charts...

Method Walidation...

Administration

SN
=HCD Toc 200302 | =
- =HE TOG 200
(] 123

Hiztary Databaze

The screen has been locked.
Enter the User 1D and Password

again.
User ID: I
Pazsword : I

Figure 3.36 Re-enter Password Dialog Box
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Software Installation

This chapter describes the procedure for installing the TOC-Control V software
used with this instrument.

4.1 Installation Precautions

Describes the precautions that should be taken when installing the
TOC-Control V software.

4.2 Installation Procedure
Describes the TOC-Control V software installation procedure.
4.3 PDF Output Settings

Describes the procedures for generating a PDF report.
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4.1 Installation Precautions

4.1

Installation Precautions

The TOC-Control V software can be installed on PC’s running under Windows95,
Windows98, WindowsNT 4.0 (SP3 or later), Windows2000 or WindowsXP. In order to
maintain FDA 21 CFR Part 11 compliance, the software must be installed with
Windows2000 at this time. Install the software while Windows is running. Close all
other applications before beginning the installation procedure.

IWindows User Accounts

Error messages may be generated on computers using Windows2000 or WindowsNT if
the Windows user ID and password differ from the one used at the time of
TOC-Control V installation. The error message indicates that the database for the User
account could not be found.

To correct this situation, log into Windows using the same user ID and password used
for the TOC-Control V installation.
Windows ME

The Windows ME operating system has low stability and is unsuitable for controlling
analytical instruments like the TOC analyzer. Windows ME can cause abnormal
operation, and in the worst case, occasionally cause the operation to stop altogether. Do
not use the TOC-Control V software with Windows ME.

PC Power Management Settings

Disable the PC Power Management function to prevent shutdown of the PC and
interruption of instrument operations.
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4.2

4.2 Installation Procedure

Installation Procedure

Since the installation procedure differs depending on whether the software is to comply

with FDA 21 CFR Part 11, use the procedure described below that suits the usage

requirement.

The TOC-Control V CD-ROM contains the MSDE database, the Shimadzu User
Authentication Tool and the TOC-Control V software.

Usage not to comply with
FDA 21 CFR Part 11

Usage to comply with FDA
21 CFR Part 11

I

Install MSDE

Install Shimadzu User
[Authentication Tool

v

Install Shimadzu User
Authentication Tool

!

v

Install TOC-Control V
software

Install TOC-Control V
software

Figure 4.1 Installation Flow

TOC-V Administrator’'s Manual
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4.2 Installation Procedure
4.2.1 Installation of MSDE Database

4.2.1 Installation of MSDE Database

If the software is to comply with FDA 21 CFR Part 11, install the MSDE database. If
the software need not comply with FDA 21 CFR Part 11, proceed to Section 4.2.2
Installation of Shimadzu User Authentication Tool.

1. Insert the CD-ROM into the CD drive.

2. Using Explorer, etc., access the drive containing the CD-ROM.

3. Execute Setup.exe.
The TOC-Control V Software dialog box opens.

8| TOC-Control W Software

TOC-Contvgl V Softpzivy

Shimadzu User Authentication Tool Eng.
Shimadzu User Authentication Tool Jpn.

STEP.2 Database

TOC-Control V Eng. MSDE Ver.1.0'Eng.
TOC-Control V Ger. MSDE Ver.1.0'Jpn.

TOC-Control V'.Jpn.

Click button to install.

Figure 4.2 TOC-Control V Software Dialog Box

4.  Click on MSDE Ver. 1.0 Eng.

This procedure is described in the Shimadzu User Authentication Tool Instruction
Manual, at the back of this manual. Continue the installation referring to the procedure
described in Section 3.2 Installation of MSDE (page 3-2).

44 TOC-V Administrator’s Manual



4.2 Installation Procedure
4.2.2 Installation of Shimadzu User Authentication Tool

4.2.2 Installation of Shimadzu User Authentication Tool

1. Insert the CD-ROM into the CD drive.

2. Using Explorer, etc., access the drive containing the CD-ROM.

3. Execute Setup.exe.
The TOC-Control V Software dialog box opens.

8| TOC-Control W Software

TOC-Contvgl V Softpzivy

Shimadzu User Authentication Tool Eng.
Shimadzu User Authentication Tool Jpn.

STEP.2 Database

TOC-Control V Eng. MSDE Ver.1.0'Eng.
TOC-Control V Ger. MSDE Ver.1.0'Jpn.

TOC-Control V'.Jpn.

Click button to install.

Figure 4.3 TOC-Control V Software Dialog Box

4. Click on Step 1. Shimadzu User Authentication Tool Eng.

This procedure is described in the Shimadzu User Authentication Tool Instruction
Manual, at the back of this manual. Continue the installation referring to the procedure

described in Section 1.2 Installation (page 1-2).
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4.2 Installation Procedure
4.2.3 Installation of TOC-Control V Software

4.2.3 Installation of TOC-Control V Software

1. Insert the CD-ROM into the CD drive.

2. Using Explorer, etc., access the drive containing the CD-ROM.

3. Execute Setup.exe.
The TOC-Control V Software dialog box opens.

8| TOC-Control W Software

TOC-Contvgl V Softpzivy

Shimadzu User Authentication Tool Eng.
Shimadzu User Authentication Tool Jpn.

STEP.2 Database

TOC-Control V Eng. MSDE Ver.1.0'Eng.
TOC-Control V Ger. MSDE Ver.1.0'Jpn.

TOC-Control V'.Jpn.

Click button to install.

Figure 4.4 TOC-Control V Software Dialog Box
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4.2 Installation Procedure
4.2.3 Installation of TOC-Control V Software

4. Click on Step 2. TOC-Control V Eng.
The Welcome dialog box opens.

TOC-Control ¥ Setup

‘Welcome to the InstallShield Wizard for
TOC-Control ¥

The InzstallShield® wWizard will install TOC-Contral % on wour
computer. To continue, click Mext.

Cancel

Figure 4.5 Welcome Dialog Box

J. Read the Welcome dialog box message, and click Next.
The License Agreement dialog box opens.

TOC-Control ¥ Setup
License Agreement

Fleaze read the following license agreement carefully.

Frezz the PAGE DOWH key to see the rest of the agreement.

[EWD-JSER LICEMSE AGREEMENT FOR SHIMADZL SOFTWARE -
TOC-Contral 4

IMPORTANT-READ CAREFULLY:

Thiz Shimadzu End-User License Agreement [“ELILA" iz a legal agreement between pou
[either an individual or a zingle entity] and Shimadzu Corporation for the Shimadzu software
product identified abowve, which includes computer software and may include associated
media, printed materials, and "online or electronic documentation ["'SOFTWARE
FRODUCT"]. By installing, copying. or otherwize using the SOFTWARE PRODUCT, vou LI

Do you accept all the terms of the preceding License Agreement? If you choose Mo, the
zetup will close. Tainstall TOC-Control ¥, you must accept this agreement.

| Frztal Shield

< Back Yes Mo

Figure 4.6 License Agreement Dialog Box
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6. Read the Agreement text, and click Yes.
The User name and S/W serial no. dialog box opens.

User name and 5/ serial no.

Figure 4.7 User name and S/W serial no. Dialog Box

7. Enter the name of the User and the serial number affixed to the case of the
CD-ROM. Then click Next.

Note: The serial number including the hyphens consists of 17 characters.
Enter the characters carefully as the serial number is case sensitive.
The Choose Destination Location dialog box opens.

TOC-Control ¥ Setup

Choose Destination Location

Select folder where Setup will install files.

Figure 4.8 Choose Destination Location Dialog Box
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8. Either accept the default folder, or select a different folder, and click Next.
The Select the functions dialog box opens.

Select Functions

o2 (= Distiller

F

Figure 4.9 Select the functions Dialog Box

This dialog box is used to set the security-related settings to make this software
compliant with FDA 21 CFR Part 11. If you do not want the software to
comply with this regulation, do not select any of the items. Leave the default
settings.

To make the software compliant with FDA 21 CFR Part 11, select the
appropriate items. Refer to Section 3.2.4 “Security” for more information.

9. After making the appropriate selections, click Next.
The SQL Server Login Settings dialog box opens.

5S0L Server Login Settings

Figure 4.10 SQL Server Login Settings dialog box
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4.2 Installation Procedure
4.2.3 Installation of TOC-Control V Software

10.

To use the Operation History function, enter an SQL Server login ID and
password. Use of the Operation History is required for FDA 21 CFR Part 11
compliance, so entry of the login ID and password is required.

If the Operation History function will not be used and FDA 21 CFR Part 11
compliance is not required, do not enter a user ID or password. Leave the
default settings, and click Next.

Reference: Refer to Section 2.2 “Explanation of System Administration Functions”, and Section 3.3
“Operation History” for additional information about the Operation History,.

11.

12.

Make the appropriate entries, and click Next.
The Installation Complete dialog box opens.

TOC-Control ¥ Setup

InstallShield Wizard Complete

Setup has finished instaling TOC-Control % on your computer.

[Earce!

< Back

Figure 4.11 Finish Dialog Box

Click Finish.

The installation is complete. A new program group is displayed under
Programs in the Start menu.
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4.3

4.3 PDF Output Settings
4.3.1 Adobe Acrobat Installation Information

PDF Output Settings

TOC-Control V software incorporates a report output function that creates documents
in PDF format (Portable Document Format). These documents are administered and
edited using Adobe Acrobat 5.0 or higher.

4.3.1

Adobe Acrobat Installation Information

Adobe Acrobat 5.0 must be installed to utilize the report function.
Note: Adobe Acrobat 5.0 Information.

* Adobe Acrobat 5.0 is not included with this software package. The user is
obliged to obtain this product separately.

*  Acrobat Distiller or Acrobat PDFWriter is required to use the PDF output
function incorporated in the TOC-Control V software. Acrobat Distiller is
installed with the Standard Setup installation of Adobe Acrobat 5.0.

*  This Acrobat PDFWriter program is not installed with Standard Setup of
Adobe Acrobat 5.0. Use the Custom Setup option to install Acrobat
PDFWriter. Acrobat Distiller should also be installed when using the Custom
Setup option.

For the installation, insert the Adobe Acrobat CD-ROM into the CD drive, and follow
the directions indicated on the AutoPlay screen.

TOC-V Administrator’'s Manual
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4.3 PDF Output Settings
4.3.2 PostScript Printer Installation

4.3.2 PostScript Printer Installation

The procedure for utilizing the PDF Output function is as follows.

1. Insert the Adobe Acrobat 5.0 Installation CDROM to start Acrobat
installation.
The Adobe AutoPlay Welcome screen is displayed.

I\ Adobe Acrobat 5.0.5 AutoPlay |

Thank you for selecting Adobe Acrobat 5.0.5

V' Show AutoPlay nest ime the CD is inserted.

Figure 4.12 Adobe AutoPlay Welcome Screen

2. Click the Next button.
The Adobe Acrobat 5.0.5 Installation screen is displayed.

A\ Adobe Acrobat 5.0.5 AutoPlay ! 101 =l

Adobe Acrobat AY

Acrobat 5.0.5 I Additional Materials

Before you install |

Install Adobe dcrobat 505 |

Browse CO-ROM contents |

[V Show AutoPlay nest ime the CD is inserted. Guit |

Figure 4.13 Adobe Acrobat 5.0.5 Installation Screen
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4.3 PDF Output Settings
4.3.2 PostScript Printer Installation

3. Select the Additional Materials button.
A list of buttons corresponding to the various supplemental software options is
displayed.

I\ Adobe Acrobat 5.0.5 AutoPlay : I ] 5

Adobe Acrobat AY

Acrobat 5.0.5 " Additional Materials I

Browse Third Party Solutions Folder Browse Security Folder

Install Makefccessible Plugin Browse Forms Folder

Browse Utilities Faolder Browse Enterprize Folder

Inztall QuickTime Browse Collaboration Folder

Browse Database Folder

| |
| |
Install PaperCapturePlugin | Browse Batch Folder |
| |
| |
Install Adobe PostSeript Printer Diiver | |

[V Show AutoPlay nest ime the CD is inserted, Guit |

Figure 4.14 Additional Materials Menu Screen

4. Select Install Adobe PostScript Printer Driver.
The Adobe PostScript Printing System screen is displayed.

I\ Adobe PostScript Printing System 100 =l
Install a PostScript Printer |
Update Existing PostScript Printers | 2

Flease make a selection. ou can also click the checkbox in the lower-left corner to disable thiz
Autoplay when this CD iz inserted in the future,

V| Show AutoPlay nest ime the CD is inserted. Guit |

Figure 4.15 Adobe PostScript Printing System Screen
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4.3 PDF Output Settings
4.3.2 PostScript Printer Installation

5. Select the Install PostScript Printer button.
Continue to accept the default values indicated on the screen until the Local
Port Selection screen is displayed.

Local Port Selection : |

Click the port you want to use with thiz printer.
Click Configure Part to view or change that port's parameters.

Awailable ports:

COM1:  Local Port
COM2  Local Port
COM3:  Local Port
COM4:  Local Paort

LPT1:  Local Port
LPT2  Local Port
LPT3:  Local Port
SMAGITE Local Port

Configure Part... |

< Back I Mest > I Cancel |

Figure 4.16 Local Port Selection Screen

6. Select “File:” for the port, and then click the Next button.
The Select Printer Model screen is displayed.

Select Printer Model |

Select the model of your printer. IF you do not find your printer listed, you can click,
Browse ta look for printers at other locations or consult pour printer documentation
for a compatible printer.

If you cannot find a suitable printer listed, select Adobe Generic PostScript Printer.

Frinters:

Acme Model &

DEFFRTRZFFD 13492 bytes 03/03/01 Browse... |
< Back I Mest > I Cancel |

Figure 4.17 Select Printer Model Screen

54 TOC-V Administrator’s Manual



4.3 PDF Output Settings
4.3.2 PostScript Printer Installation

7. Select the Generic PostScript Printer option, and then click the Next button.

Continue to accept the default values until the Printer Information screen is
displayed.

Printer Information x|

*r'ou can uze the following name or enter another name for this
printer.

Pritter Name: | Generic PostS cript Printer

Do you want to uze thiz printer az your default printer?
 Yes

@ No

‘wiould wou like to print the test page?

" Yes [Recommended)

' No

< Back I Mest > I Cancel

Figure 4.18 Printer Information Screen
8. Verify that the Printer Name is indicated as “Generic PostScript Printer.” For

the setup questions, “Do you want to use this printer as your default printer?”
and “Would you like to print a test page?”, select No to both.

Click the Next button and proceed following the directions on the screens to
complete installation of the printer driver.
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Before Using The Shimadzu User Authentication Tool

Thank you for purchasing CLASS Agent Software. Before using this software, please read this man-
ual carefully to get the most out of your software.

Thisinstruction manual describes how to use and operate CLASS-Agent Manager. It assumes that you
should be familiar with some features in Windows 98/NT/2000; you should have some hands-on expe-
rience with the mouse and keyboard.

In this instruction manual, basic terminology used in Windows 98/NT/2000 are used to explain about
how to do anything in CLASS-Agent Software. For definitions of unfamiliar words, please refer to the
Windows 98/NT /2000 manud.

If you are afirgt-time user of Windows 95/98/NT, please read the Windows 98/NT/2000 manual be-
fore reading this ingtruction manual.

Handling Precautions

1 This Softwareis and remains the proprietary property of Shimadzu Corporation.

2 No part of this Software may be copied or reproduced in any form or by any means, except for
installation and routine backup. No part of this Software may be leased, assigned, transferred, re-
compiled or altered in any form or by any means.

3 Shimadzu Corporation shall not be liable to the purchaser or any other person for any loss or dam-
age arising out of the use or operation of this Software.
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About The Shimadzu User Authentication Tool

This software (hereafter referred to as “Shimadzu User Authentication Tool”) controlsunitarily
the user information used in Shimadzu applications.

When the user information of the CLASS-Agent, the LabSolutions, etc. is controlled by this User
Authentication Tool, the common database (user authentication database) which does not de-
pend on applications is used. The User Authentication Tool is equipped with the utility functions
to display the access log, create new servers, set the configuration, etc. to this daiabase.

About the Instruction M anual

The authors have used their best efforts in preparing this document by providing up-to-date in-
formation as much as possible, but the information and software discussed in this document are
subject to change due to nonconformity. For the latest information, please read the contents
written in the README2.TXT file, afile that is saved to the program directory of this software
during an installation process.

The names of data processing software and equipment are expressed in the form of generic
names. Modd names and type names are indicated as may be deemed necessary to identify any
software or equipment.

Asused in thisinsgtruction manual, this software package is referred to as “ CLASS-Agent Soft-
ware” where appropriate.

Warning Signs
The following warning signs are used throughout this instruction manual.

[CAUTION] indicates apotentialy hazardous situation where, if not avoided, any damageto
property may be caused.

[NOTE] emphasizes additiona information that is useful to increase efficiency of opera-
tions and to enlarge an understanding of topics.
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1 Installation Procedures

1.1

Outline

The Shimadzu User Authentication Tool can easily control and attest usersin analytical
applications.

* The User Authentication Tool offers the following functions.

1. Thetool realizesthe User Authentication security by the login/logout processing using the
login ID and the password. In addition, the tool can set in details the password length, the
validity, etc. for each personal computer and each user.

2. Thetool controlsthe user information (such as the name, the section and the address)
based on the database. Because the tool can be connected to the rigid database such as the
SQL Server/MSDE, it can realize easily the security at high level.

3. Becausethetool is equipped with the advanced audit trail function, the system
administrator can trace the information on each user.

4. Network function

Because the tool correspondsto the LAN consisting of client and server, the information
related to the user login can be unitarily controlled in the server.
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1 Installation Procedures

1.2 Installing Software
The following installation procedures assume that you are installing from a CD-ROM.

Procedure
1) Gather aCD-ROM disk for CLASS-Agent Software. Then insert the CD-ROM disk into
your CD-ROM drive.

2) With the CD-ROM disk inserted, the installation wizard appears as shown below.

B sHIMaADZU

Sotmidomr for Solenie

[NOTE] If theinstallation wizard does not automatically start up, or if you reboot the
Windows program, you can install programs by using the Run command in
M S-Windows 95/98/NT. Choose [Start] — [Run] to open the <Run> dialog box.
Click the [Browseg] button and then choose a SETURPEXE program from the root
folder on the CD-ROM. Then click on the OK button to run the setup program.

- The <Run> dialog box -

Run |

Type the name of a program, Folder, document, or
Interrnet resource, and Windows will open it far yaou,

CIpen;: I d:lsetup j

K, I Zancel | Browse, ., |
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1 Installation Procedures

1.2.1 Setting up The Shimadzu User Authentication Tool

1) You will seealisting of CLASS-Agent components. Click on the [ Shimadzu User
Authentication Tool] package button.

¥ [LASS-Agent Software 1 3

(CIPALS S TAT CITIR

| CLASS Agent Manager

STEP.3

& - gen

[ CTASSalance Agent
[ Gesolution Agent
EEEE'& gqn
‘LCMSsolution Agent
[ Reloee ota
Click each Button to Start each instaliation =
2) After you have specified which component to install, the installation program for the

selected component starts up. In the installation wizard, click on the [Next] button to
proceed as instructed on-screen.

Welcome

YWelcome to the Shimadzu usger authentication tool
Setup program.  Thiz program will install Shimadzu
- uzer authentication tool on vour computer.

[t i gtrongly recommended that vou exit all wWindows programs
before munning thiz Setup program.

Click Cancel to quit Setup and then cloze any programs pou
have mnning. Click Mest to continue with the S etup program.

WAARMIMG: This program iz protected by copenght law and
international reaties.

IInauthonized reproduction or distibution of thiz program, or any
portion of ik, may result in zevere civil and criminal penalties, and
will be progecuted to the masimum extent poszible under lav.

Cancel |
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1 Installation Procedures

3) Clicking on the [Next] button will display the next screen.

Setup Order |

Pleaze ingtall fgent Software az follows.

1.5himadzu uzer attestation tool ;l
2 80ent Manager
2 Each Agent sofbware

. o
Cancel |

4) If you click on the [Next] button, the next wizard screen appears to start the installation
process.

< Back

o b -0 el 1l

Sl pnondzar ser e ffrenfication ool

*E hrughoy irser avibee esios o
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1 Installation Procedures

5) And then, the next wizard screen appears. Click [OK] button at the first installation.
When re-installation or ActiveX Data Objects (ADO) has been already installed
by installation of the Microsoft Office, click [No] button.

- About re-installation -

Question |

Setup program Found 00 of 2.5 or better version,
Do wou wank o overwribe?

6) You will see amessage indicating that the installation was completed successfully. Then
click on the [Finish] button.

Setup Complete

Setup haz finighed ingtaling Shimadzu uzer attestation tool on
your computer.

Setup zan launch the Bead Me file and Shimadzu uzer
attestation tool. Choose the ophions pou want below.

Click Finizh to complete S etup.

< Back

Install the application software “ Class-Agent” consecutively. For the installation method,
refer to the “CLASS-Agent Software Installation Manual (223-10053)".
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2 Shimadzu User Authentication Tool

2.1 Shimadzu User Authentication Tool
2.1.1  Startup of program

1) From[Settings] offered by the [Start] button on the desktop, select “ Control Panel”.

Programs ¥
Documents ¥

Settings B3 cControl Panel

< h . Metwork and Dial-up Connections
Earc

@ Prinkers
Help a Taskbar & Start Menu, .,

Al

&

Run...
L]

h

2) Double-click the “ Shimadzu authentication tool” icon.

e 5 e rpas o e %

| et - = - | Disewch Erokers Frimoy | W B ¥
| mgiveess | orirod P =] e |
< =]
G o 3 D =
It st Foarphimean| Hrame sty arul
Ol Cisdags Ci..

$ 4 =2 @ P
Hure au]  Posver Jphors Prrders Angona F
Pt .. D S whals s

i ]

& ¢« & B

Sehachied Liwars s Seunck ared Spalsi Scaivprs gl

Tasiks Paswerds  Multimeds e =

[NOTE] No user accounts have been created during the installation.
Define a password surely for the login ID “Admin”.
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2 Shimadzu User Authentication Tool

2.1.2 Main screen

The figure below shows the main screen of the Shimadzu User Authentication Tool. Execute
each function through this screen.

- The main screen. -

Configuration

Sets the configuration of the user View event log
authentication tool. o Displays the event log
For this setting, the administrator list.

privilege is required.

Change Server
Changes the MSDE (SQL) server
to be referred .
In the change destination
personal computer, the Shimadzu
user authentication server should
be created.

View user list
Displays the registered
user list.

‘f" User authentication tool of Shimadzu ¥er.1.03

Setup of the/user authentication toal.

=i Configuration / k ‘ View event log

== Change Server View user list

(=N Create New

Server | COMWINNTYSystem 32, SMZATST . MDE

Create New Cancel Lockout
Creates a new user authentication Cancels the User and
server. For creation, the MSDE (SQL) PC lockout state.
server should be set up in this
personal computer, or this personal Exit

computer should be connected
through the LAN to a personal
computer in which the MSDE server

Exits the user
authentication server.
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2 Shimadzu User Authentication Tool

2.1.3 Configuration
= Configuration ‘

Click the [Configuration] button to display the <Login check> screen.

ISHIMADZU

Solutions for Science
2ire 15T

Lagin ID |I'i|:|""||"| K

Eassmurd | Caricel |

Enter “Login ID” and “Password” and click the [OK] button to display the <Configuration of
user authentication tool> screen.

Click the [Cancel] button to cancel login.

Click the [Help] button to display the <Help> screen.

2.1.3.1 Configuration setting of user authentication tool

Set the configuration of the User Authentication Tool.
If the User Authentication Tool is shared by two or more Shimadzu applications, setting
changes are effective to all Shimadzu applications.

- <Configuration of user authentication tool> screen -

ELINE MR PSS! OF CRYraCies MeOuinssd for B DS

Winimurm posswornd b |t CHaraciers Mz pasEsord ooe |-.' £y
1™ Siaimll jhirssnapDndl & pafmind

B Podsaanins midsh st COiFpiEely reauramenin

L o b ERT AN |r::. mnuEL Ly b bl Wi ['- i Bad Kppn aT=mjls
P g b phiiabns F_ mmnuiEi PO e b @ ['__ 3w ke aEsmps
Descrpaon o ~
i wr IL
Dtz Lindaie Exk

Sarve | nagilde

1)  Minimum password length: (0 to 14 characters)
Set the minimum number of characters required in the password.

[NOTE] When the minimum length of password is changed, this setting become effective at
the next time of changing password.
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2 Shimadzu User Authentication Tool

2)

3)

4)

5)

6)

7)

8)

9)

10)

11)

12)

Maximum password age: (0 to 3650 days)

When the maximum age is expired since the latest password was set, the warning is
displayed.

If “0" is set here, the maximum age is indefinite, and the warning is not displayed.

Same password is per mitted:

The previously set password is permitted.

If thisitemis set ineffective, the previous password is not available when the
password is changed.

If it isrequired to change the password periodically, set thisitem ineffective.

Passwor ds must meet complexity requirements:
A password must be consisted of both alphabet and the numeral characters.

User lockout duration: (0 to 9999 minutes)

If login has failed beyond the specified number of bad logon attempts by a user, the
user cannot log in for the specified duration. This function is offered to prevent
illegal login by the third party.

If “O" is set here, the user lockout function is ineffective, and any user can continue
the login operation endlessly without regard to the number of bad logon attempts.

User lockout after: bad logon attempts (0 to 999)

Set the number of bad logon attempts (password input error) permitted in one user.
If “0" is set here, the user lockout function is ineffective, and any user can continue
the login operation endlessly without regard to the number of bad logon attempts.

PC lockout duration: (0 to 9999 minutes)

If login has failed beyond the specified number of bad logon attempts by a personal
computer, the login operation from the personal computer is not permitted for the
specified duration. Thisfunction is offered to prevent illegal login attempted with
different user IDs by the third party.

If “O" is set here, the PC lockout function is ineffective, and the login operation can
be continued endlessly without regard to the number of bad logon attempts.

PC lockout after: bad logon attempts (0 to 999)

Set the number of bad logon attempts (password input error) permitted in one
computer.

If “0" is set here, the PC lockout function is ineffective, and the login operation can
be continued endlessly without regard to the number of bad logon attempts.

Description:
Enter acomment in up to 255 alphanumeric characters.

[Default] button
Click the [Default] button to adjust the ER/ER default values.

[Update] button
Click the [Update] button to update the changed set values.

[Exit] button
Click the [Exit] button to exit the <Configuration of user authentication tool> screen.
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2 Shimadzu User Authentication Tool

2.1.4 Change Server

==f) Change Server

Click the [Change Server] button to display the <Change server> screen.
Two or more User Authentication Tool can exist in the network. In this case, select the
personal computer in which the User Authentication Tool to be used exists.

2.1.4.1 Change Server
- <Change server> screen -

Lhange server [ i

Enter the server name [FLC name)
I something ather than TEPAP is selected n the netwark ibrary,
an account far this PC s required at the server. (WindowssNT, 20007

= SO ServerT MSDE ™ Access MOE

Sarver name . | |

Meswaork library |Tl" =i[= j

| O | Cancel |

1) SQL Server7, MSDE
Select this item when sharing the same User Authentication Tool with other personal
computers.
Two or more sharing personal computers can refer to and control unitarily one user
information. When this item is selected, the dropdown list of “Network library” is
effective.

2) AccessMDB
Select thisitem when this personal computer is not connected to the network or only
this personal computer controlsindependently users. When thisitem is selected, the
changed configuration and usr information are effective only in this personal
computer, and the dropdown list of “Network library” is not effective.

3) Server name:
Enter the server (personal computer) name in which the User Authentication Tool is
set up.
When “Access MDB?” is selected in 2), the User Authentication Tool becomes the
MS-Access format (*.MDB). A file “ ShimadzuAttestServer MDB” is stored in the
setup folder of each Shimadzu application. Specify thisfile.
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2 Shimadzu User Authentication Tool

4) Network library:
Select anetwork library from the dropdown list.

“Named pipe’ Select this library when the User Authentication
Tool isset up in the MS-Windows NT, and
“NetBEUI” isused as the network protocol.

When selecting thislibrary, the user account should
be set in the Windows NT.

“TCP/IP’ Select this library when the User Authentication
Tool is set up in the MS-Windows NT or the
Windows98 (MSDE only), and use“ TCP/IP” asthe
network protocol.

“Multi protocol” Select thislibrary when two or more servers are
using different network protocols. When this
library is selected, the network protocol available at
first is automatically selected to establish
connection.

Click the [OK] button to change the server.

Click the [Cancel] button to cancel change of the server.

(For the detailed explanation related to the network library, refer to the manuals of
the Microsoft SQL Server, the Acesss2000, etc.)

2.15 Create New

I\ Create New

Click the [Create New] button to display the <Create new user authentication tool> window.
Create new user information database.

Prior to creation, this personal computer should be connected through the LAN to a personal
computer in which the MSDE or the SQL Server7 is set up.
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2.1.5.1 MSDE (SQL Server) login property

- <Create new user authentication database (MSDE (SQL Server) login properties)> screen -

Create new weeEr authentication databiase

MSODE(SQL Server) login properes

Enter the server name, login I and password
Fequires System Adminestrator or equivalent authority
If this P s used, enter "(local)® as the server name

SeMvar name ; |nf--:u:a|_|

LoginlD :  [za
Eassword : |
letvecrk bbrary . [TCPAP B
- -+ x 7
i [end Lancel Help

1) Server name
Enter the server (persona computer) name in which the MSDE (SQL Server7)
exists.
Enter “local” to set the server in this personal computer.

2) Login-1D:
Enter “sa (System administrator)” of the server in which the MSDE (SQL Server7)
exists or thelogin ID having the equivalent privilege.

3) Password:
Enter the password of the sa (System administrator).

4)  Network library:

Select a network library from the dropdown list.

For the setting method, refer to “2.1.4.1 Change server 4)”.
5)  [Next] button

e
Ment

Click the [Next] button to proceed to the next screen.
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2 Shimadzu User Authentication Tool

6) [Cancel] button

X

Cancel

Click the [Cancel] button to cancel creation of the Shimadzu User Authentication
Tool.

7)  [Help] button
?

Help

Click the [Help] button to display the <Help> screen.

2.1.5.2 Create application’sadministrator

Click the [Next] button to display the <Create new user authentication tool (Create
application’s administrator)> screen.
The user created hereis required to start up Shimadzu applications.

- <Create new user authentication database (Create application’s administrator)> screen -

Crieale new deer althenbbe atinn dal sk

Zreats applicaton's administrator

Creae adminestrator for applications
Thizs creates users for applications
The password must contain at least B characters
Utser mput (I and password] is required when starting up the application

UserD: |

Password [

Pasoword check |
*- - x ?
Back Baxt Cancel Help

1) User-ID:
Enter the system administrator referred to by Shimadzu applications when the User
Authentication Tool iscreated. ThelID isfixed to“Admin”.
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2)

3)

4)

5)

6)

7

Password:

Enter the password in 6 or more a phanumeric characters.

Enter the password using less than 6 a phanumeric characters. In such a case,
however, change the password before starting the operation from each Shimadzu
application, or change “Minimum password length” on the <Configuration of User
Authentication Tool> screen.

Password check:
Enter the password again.
Never forget the password because it is required to start up Shimadzu applications.

[Back] button

g
Baclk

Click the [Back] button to return to the <Create new user authentication tool (MSDE
(SQL Server) login property)> screen.

[Next] button

=Y
[et

Click the [Next] button to proceed to the <Create new user authentication tool
(Preparation was ready)> screen.

[Cancel] button

X

Cancel

Click the [Cancel] button to cancel creation of the Shimadzu User Authentication
Tool.

[Help] button
?

Help

Click the [Help] button to display the <Help> screen.
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2.1.5.3 Preparation wasready

Click the [Next] button on the <Create new user authentication tool (Create application’s
administrator)> screen to display the <Create new user authentication tool (Preparation was
ready)> screen.

- <Create new user authentication database (Ready to create)> screen -

Create now ueeEr aatheentication databiase

Henr?.lll"nl- o craafe
Wiou can create a new database
Chck the Create button
- e b 4 7
Eack Create Lancel Help

1) [Back] button

g
Baclk

Click the [Back] button to return to the <Create new user authentication tool (Create
application’s administrator)> screen.

2) [Create] button

O

Credte

Click the [Create] button to start creation of the User Authentication Tool.

If something iswrong with the network connection or if the MSDE (SWL Server7)
IS not operating on the server computer, an error occurs.

The creation status is displayed on the screen.
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3) [Cancdl] button

X

Cancel

Click the [Cancel] button to cancel creation of the Shimadzu User Authentication

Tool.
4)  [Help] button
?
Help

Click the [Help] button to display the <Help> screen.

2.1.6 View event log

View event log

Click the [New event log] button to display the <Login check> screen.

LISHIMADZU

Solutions for Science
siroa 1&TS
Login 1T |-".:."IIIII | 0K I
P agamwnd | Cancel

Enter “Login ID” and “Password” and click the [OK] button to display the <Event log>
screen.

Click the [Cancel] button to cancel login.

Click the [Help] button to display the <Help> screen.
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- <Event log> screen -

= | O | s [ o
Condiion Copy For =
|User name  |Siperanon |ﬁe-s_u; lirformna
Syetern Adrmn Liser Add CH best
4] | ¥
Servar | CIWIRKTYSyshenH, SMEATST HDE Feeconds 11 |

1) [Condition] button

Click the [Condition] button to set the extraction condition.
2) [Copy] button
]

Copy

Click the [Copy] button to copy the event log data to the clipboard. Because the
event log datais copied in the CSV format, it can be copied as atext delimited with
commacto texts of other editors.

3) [Print] button

&

Frint

Click the [Print] button to print out the event log list.

4)  [Font] button

A

Font

Click the [Font] button to specify the font for the event log list.

5)  [Exit] button

I

Exit

Click the [Exit] button to exit the <Event log> screen.

2-12



2 Shimadzu User Authentication Tool

6)

Display contents
Login date:
Computer name:

User ID:
User name:
Operation:

Configuration setting:

User Add:

User Edit:

User Dell:

User Restore:
Result:

OK:
WN:

NG:
Information:

Software;

Description:

Date and time when the operation was performed
Personal computer name in which the operation was
performed

ID of the user who performed the operation

Full name of the user who performed the operation
Contents of operation

The configuration of the User Authentication Tool
was changed. (This operation is recorded only when
the “Configuration” menu of this programis
executed.)

A new Shimadzu application user was registered.
(The following operations related to users are
executed and recorded by each Shimadzu
application.)

The registered user information was changed.

The registered user information was deleted.

The deleted user information was restored.

Status indicating whether the setting was correctly
executed

The setting was correctly executed.

There was no problem in the setting, but there was
nonconformity.

An error occurred, and the setting was not executed.
Contents of operation performed to the User
Authentication Tool

Shimadzu application program name which
performed the operation to the User Authentication
Tool

Comment entered by the user during change
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2.1.6.1 Extraction Condition

Click the [Condition] button to display the <Extraction Condition> screen.

On this screen, the event log extraction condition can be set. For example, if there are too
many linesin the default status and the screen is difficult to look at, use this screen.

Set each target check item to ON, and enter the extraction condition in the text box on the
right side. If two or more check items are set to ON, event logs which satisfy all the
conditions are extracted.

- <Extraction Condition> screen -

Extraction Condition E

Configuration of extraction parameters.
Select status of items and check the baoxes
an the left. Then click Ok button to extract
event log with set extraction condition.
Feriod [ | saturday , January 01,2000 2
o | Saturday , Juy 20,2002 4
Lger [ I
Liser full name [ I
Result ok =
Qperation r IUserAdd ]
BC name [ I
Software [ I
Infarmation [ I
Description v I
0K Cancel
1) Period

Set the event log period of the data to be extracted.
Check the check box to enable the combo box for operation.
Drop down the combo box to display the calendar.

2)  User
Enter the user ID of the datato be extracted and displayed.

3)  User full name
Enter the user name of the event logs to be extracted.
The entire full name does not have to be input.
The logs of the user names including the input characters are extracted and

displayed.

4) Result
Among “OK”, “WN" and “NG”, select the result of the data to be extracted.

2-14



2 Shimadzu User Authentication Tool

5)  Operation
Among “User Add”, “User Edit” and “User Dell”, select the operation of the datato
be extracted.
6) PC name
Enter the personal computer name in which the data to be extracted is registered.
7)  Software
Enter the software name (Shimadzu application name) of the data to be extracted.
8) Information
Enter the contents on the data to be extracted.
9) Description
Enter the comment on the data to be extracted.
10) [OK] button
Click the [OK] button to make the set extraction condition effective and reflect it on
the list.
11) [Cancel] button
Click the [Cancel] button to make the set extraction condition ineffective and return
to the <Event log> screen.
2.1.6.2 Font

Click the [Font] button to display the <Font> screen.
The font specified on this screen is reflected on screens and printouts.

- <Font> screen -

Fr O s - |- |
Font: Faont style:

Im IHeguIar

-
Arial Black [talic

Hr Avial Marrow Baold

B Bookman Old Style Bald [talic
i Bookshel Sypmbol 1
B Bookshelf Spmbol 2

]9 I
Cancel |

B Bookshel Symbol 27

—Effects — Sample
[ Stikeout
™ Underline AzBhvyEz
Color:
I- Black. ;l Script:
IWestern LI
1) Font:
Specify the font type.
2) Font style:
Specify the font style.
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3) Size
Specify the font size.

4) Effects
“Strikeout” and “Underling” can be added.

5  Color:
Specify the font color from the dropdown list.

6) Sample
The font specified on this screen is displayed as preview.

7)  Script:
“Japanese” is automatically displayed here when the font type selected in “Font” isa
Japanese one.
“Western” is automatically displayed here when the font type selected in “Font” isa
Western one.
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2 Shimadzu User Authentication Tool

2.1.7 View user list

View user list ‘

Click the [View user list] button to display the <Login check> screen.

ISHIMADZU

Solutions for Science

2ire 15T

Lagin ID |I'i|:|""||"| K

Eassmurd | Caricel |

Enter “Login ID” and “Password” and click the [OK] button to display the <User list> screen.
Click the [Cancel] button to cancel login.

Click the [Help] button to display the <Help> screen.

- <User list> screen -

Ll THTE _ | O] =
ooy Fom Ean
rd Pz chafifl ngme  |Comrpany | Sechon Lk e lenore g e
20078100 08 System Admin
st 20ATIRT 1H;test
ETEmM ANEEALSA 1 2 ULASE-NE Y
4] | x|
Sorees | CIWINTI st 121 SHEATST M08

1) [Copy] button
]

Copy

Click the [Copy] button to copy the user information data to the clipboard. Because
the user information datais copied as a text delimited with commas, it can be copied
to texts of other editors.
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2) [Print] button

&

Frint

Click the [Print] button to print out the user information list.

3) [Font] button

Font

Click the [Font] button to display the <Font> screen.
On this screen, specify the font for the user list. For the details, refer to “2.1.6.2
Font”.

4)  [Exit] button

Click the [Exit] button to close the <User list> screen.
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2 Shimadzu User Authentication Tool

2.1.8 Cancel Lockout

¢» Cancel Lockout

Click the [Cancel Lockout] button to display the <L ogin check> screen.

LISHIMADZU

Solutions for Science

sinca 1ETS

Losgin I ||:A."||||| | Ok I

Pagsvwnnd | Cancel

Enter “Login ID” and “Password” and click the [OK] button to display the <Confirm> screen.
Click the [OK] button. Cancels the User and PC lockout state.

Lockout of all users and PCs are canceled,
Sure?

2.1.9  Exit
=[1 Exit

Click the [Exit] button to terminate setting of the Shimadzu User Authentication Tool.
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3 Network Shared Settings

Outline

This chapter explains The Shimadzu User Authentication Tool while picking up a setting
example in which thetool is shared in the LAN. In order to share the tool in the LAN, one
personal computer which acts as the database server is required. As the server database, the
SQL Server or the MSDE isrequired.

The MSDE is the database engine of the SQL Server offered by Microsoft free of charge. Itis
customized for small-scale database systems.

Because each client personal computer refersto the database of the user authentication existing
in the server, the information can be unitarily controlled.

=
)

Server personal computer || =i Database
= (SQL Server/MSDE)

The user authentication
is unitarily controlled
here, and logged in
through the server

ersonal computer.

Ethernet ‘

=1
— ]

[ = — 1 ] T [
Y=\
\ \
L 1 1 1 — [
Client personal computer Client personal computer Client personal computer
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3.2

Installation of MSDE
This paragraph describes how to install the MSDE from the CD-ROM.
Install the MSDE to server persona computers. You do not havetoinstall it to client

personal computers.
If the SQL Server manufactured by Microsoft is already installed, installation of the MSDE is

not required.

Procedure
1) Atfirst, insert the CD-ROM of the CLASS Agent software into the CD-ROM drive, and
install the MSDE.

2) Inseveral seconds after the CD-ROM isinserted into the CD-ROM drive, the following
logo is automatically displayed.

(] sHIMADZU

Splmitenr for Soence

[NOTE] If thelogo shownin 2) isnot displayed in automatic startup or if the Windowsis
started up again, select <RUN(R)> from the [Start] button of the MS-Windows
95/98/NT.

When the <RUN> dialog box is displayed, select and enter * setup.exe” from the
route folder in the CD-ROM using the [Browse] button, then click the [OK] button.

- Structure of the <RUN> dialog box -
Riimn EE

Trpa the name of & progeam, folder, dotumant, o
Int=rnet resoorce, and YWircdows will open it For vou,

gpen: | diisetup |

| (e | Cancel Browsse... |
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3.2.1  Setup of MSDE (only in server personal computer)

1) Select the package type to be installed on the screen, and click the [MSDE Ver. 1.0]
package button.

¥ CLASS-Agent Software =] E3
CISANS S AR CITLIS ON VAT
STEPA1 Client/Server Database

Shimadzu User Authentication Tool DB Utility for SOLServer

STEP.2 [ MSDE Ver.1.0 h
_—crﬁs'ﬂmw

STEP.3

[EASS P Rgent [ETRSSUUPTobe Rgent
[ CTASSTalance Rgent [ETASSPublc Agent
[ G Geolution Rgomt [FWiRRd Gateway

GCMSsolution Agont

LCMSsalution Agent

= Ralose Note
k each Button to Start each installation Bt
2) Confirm the folder in the temporary area used to install the M SDE.

Specify the hard disk having free space of 150 MB or more, then click the [Continue]
button.

MSDE - Installation Folder E3 |

Pleaze enter the folder where the files zhould be unpacked.
I the folder does not exist, you will be prompted to create it.

Installation Falder
IE:'\Temp'xMSDE

Browse... |

[mstallShield

Cantife I Cancel
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3) When the package is selected, preparation for setup starts. After awhile, the following
screen is displayed.
Click the [Next] button on the screenin turn.

T

MSDE

e R
g e L i

By i
i;ln-—nil-hrnn

T Cisd Tt el B
l;.- -Ea—-

i i wwl
canend
e e

Next Button

4) Click the [Next] button to display the following screen.
Specify the MSDE installation destination. In the installation destination, the hard disk
should have free space of 200 MB or more.

Choose Destination Location |

Setup will ingtall MSDE in the following folder.
Tainztall to this folder, click Nest.

To ingtall ko a different folder, click Browse and zelect another
folder.

‘Y'ou zan chooze not to install MSDE by clicking Cancel to exit
Setup.

C:AMSS0LT Browee... |
Cancel |

’* Deztination Folder

< Back
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5) Click the [Next] button to display the following screen and start installation.
Installation will be finished in 15 to 60 minutes depending on the hardware configuration.
Wait until the message for restart is displayed.

MSDE

MSDE Setup
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6) When installation is completed, the following message is displayed.

Setup Complete

Setup haz finighed copying files to wour computer.

Before pou zan uze the program, you muzt restart Windows o
Waur computer,

% ez, | want bo restart my computer now

™ Mo, | will restart rmy computer later.

Rermove any dizsks from their drives, and then click Finigh to
complete zetup.

¢ Back I Finizh I

Restart the computer in accordance with the instruction.

After restart, when the contents shown below are displayed on the task bar, the installation
is completed.

|®%@ 949 AM

f
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3.3 Setup
3.3.1 Creation of authentication database (only in server personal
computer)
1) Start up The Shimadzu User Authentication Tool by selecting “ Settings’-*“ Control Panel”
and double-clicking the tool icon in the server personal computer. Click the [Create New]
button.

¥ lser suthenticatisn ool of Shimesd Ver, 1801

S=hip of e e mifesicwion ool

| (=5l Configuration A View event log

=uH Change Server &1 View user list

mmm) '\ Create New 3 Cancel Lockout

=1 Exit

narw - O M PINT T yaban 1T TR TST MOB

Enter “Admin” for login after displaying the login menu.

2) Enter the name (or IP address) of the current computer to “ Server name”, and click the
[Next] button.

Create new user autkenticstion datshaze

MSDE(SQAL Server) Iomn proparies

Enter the serser name, login [0 and passward
Requres Sysierm Adminisranr o equssEent authorndy
¥ this PC is used, enter "{lacal)® as the server name

SieTver name ||:i-:-: al)

LeeqinelC |5El
Paseword |
Matwork library - [TCPAP =
- - xX ; 4
I Pdsat _ancal Helo

The server personal computer name is displayed on the “Network and Dial-up
Connections” identification tab of “ Control Panel”.
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3) Thisisthe system administrator’s password input phase.
Because the password can be changed later using the Agent Manager, click the [Next]
button.

Create new gser suthenbicabion dat shse

_raate application’s administrator

Create administrator for applications
Thiz creates users for EII:IFIECBIJIZII'IE
The |.'I.35']l.'dl'.ll'ﬂ must contain at least 6 characters
Liger inpet (10 and pessword) o required when siartng up the apglication

Lser-ID |

Bassword . |

Fassword check |

- -+ x 7
Back Mgsod Cancal Halp

Though awarning is displayed because the system administrator’s password is not set,
ignore the warning and continue the setting.

4) Click the [Create] button to create the database for authentication.

Create new user authenticabion datshase

Feady o create

10U can creals a new databass
Chck the Create button

=
Back

(e, X 7

Create ance| Help

Now, the database for user authentication is created in the server personal computer.

Next, in the client personal computer, perform the setting to connect the server personal
computer.
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3.3.2 Connection to server personal computer (only in client personal
computer)
1) Intheclient personal computer, start up The Shimadzu User Authentication Tool from

“Control Panel”.
Click the [Change Server] button.

V¥ Lser suthwenticstisn bool of Shimeso Ver, 1801

| (=4l Configuration S0 View event log
mmm) = Change Server 471 View user list
(=N Create New @ Cancel Lockout
=1 Exit

Sarewr = panyl D4

Enter “Admin” for login after displaying the login menu.

2) Enter the name (or IP address) of the server personal computer to “ Server name”, then
click the [OK] button.

Enter e server name [FL name)
I something ather han TOPAP 5 selected n thie netsark ibrary,
an account for this PC s required at the server. (WindowesHT, 2000)
= SOL Server T MSDE i~ Access MOE
Sarver name | |
Metwork library |T"' =AF j
| L .4 | Cancel

3) When the message shown below is displayed, the setting of the client is completed.
After that, the user information is unitarily controlled by the server personal computer.

Information |

The user authentication database was recognized,
eaqlld is available,
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